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1. General Information 

The UStretch is a precision test instrument specifically designed for the measurement and analysis 
of biological specimens. The system includes a test station and an integrated software interface to 
run and analyze test results. 

Environmental and Electrical Specifications 

Electrical Input 100-240VAC, 50-60Hz 

Current Rating 2.5 Amp 

Environmental Conditions Maximum Operating Temperature 25ºC 

0% - 95% Relative Humidity 

Installation Category Category II 

Pollution Degree Degree 2 

Data Connections 1 – USB for controller/PC communication 

1 – USB for camera/PC communication 

System Assembly 

Some basic assembly and setup is required.  An unboxing and setup guide can be found in 
Appendix A.  Camera setup (Section 8: System Calibration), software installation (Appendix B), 
and load cell/gooseneck installation (Appendix C) are required before use. 

Connections to Supply 

Connect power cord into properly grounded 100-240VAC power source to ensure safe operation. 
Ensure that the power cord is easily accessible at all times. The use of an Uninterruptible Power 
Supply (UPS) is recommended to protect against data loss. 

The mains supply voltage fluctuations should not exceed 10% of the nominal supply voltage. 

Safety Warnings 

This equipment must be used in accordance with the procedures outlined in this manual and 
operators of this equipment must be instructed in safe operating procedures to prevent injury and/or 
damage. 

Ensure that the area around the moving bracket is clear before commencing test protocols. 

Keep hands clear of moving parts for the duration of the test. 

 

System Alert 

This equipment must not be disassembled by the user or modified in any way. 
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Manual Operating Controls 

There are a few manual controls on the unit. The camera lens has a focus, zoom, and iris ring 
which can be set by the user.  

 

UStretch Tip: Setting Camera Controls 

The iris is usually left 100% open; the brightness of the images is better adjusted by 
changing the camera gain and exposure. 

 

There are two switches on the front of the control unit, one for powering the control board and 
another for powering the heating element for the fluid bath.  

General Maintenance 

Clean the system as needed with mild soap and water or alcohol based cleaning solutions.  

Approvals and Certification 

This product conforms to applicable CE standards. 

 



UStretch User Manual 

3 

 

2. Testing Terminology 

The UStretch is designed to apply uniaxial forces to soft material specimens (deforms by more than 
1% in vivo) with a test axis dimension of 3 - 60 mm. This includes biological material such as eye 
tissue, heart valves, pericardium, joint capsules, and large blood vessels. 

Multiphase Test Cycles 

In order to properly characterize and test a specimen, it is often necessary to load it to different 
degrees and at different rates. There are three main reasons for doing this: 

Preconditioning - The goal of preconditioning is to restore a specimen to its physiological or 
in vivo state. During the process of specimen storage and preparation, a specimen may swell, 
dry out, have its material fibers realign, or its molecules reorganize. It may take multiple 
preconditioning cycles for a specimen to be restored to its natural state. 

Reproducing Physiological Conditions During Testing - By applying various loads and load 
rates, natural expansion and contraction of a specimen can be reproduced (for example, the 
pulse pressure in an organ). In as much as the physiological conditions can be recreated, the 
specimen can be tested in a more realistic state. 

Varying Test Conditions - Variable loads and rates allow you to create a variety of test profiles 
to best study your specimen. 
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Phases, Cycles, and Test Sequences 

As the following diagram demonstrates, each application and release of load on the specimen is 
called a test cycle. The same test cycle can be repeated multiple times to achieve a certain goal 
(preconditioning, physiological conditioning, or testing); this is called a test set. Finally, a test 
sequence is made up of multiple test sets.  

 

The above example describes the following: 

 The entire diagram presents a full test sequence.  

 Within that sequence, there are two test sets: the first set applies preconditioning to the 
specimen; the second set executes the actual test on the specimen.  

 Within the first set (preconditioning), two identical test cycles are implemented to bring the 
sample to a satisfactory in vivo state.  

 Finally, the second set (testing) is made up of three cycles.  
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Test Phases: The Smallest Unit of Testing 

The test phase is the smallest unit of the test specification. There are five phases within a cycle. 
Each phase serves a specific purpose: 

Preloading- Preloads are applied to bring a test 
to a well-defined starting point. Because the 
dimensions of a specimen may change as a result 
of a loading cycle (stretching of fibers, viscoelastic 
effects, plastic deformation, or localized material 
failure at the attachment points), the preload 
adjustment compensates for any of these changes 
in specimen geometry.  

Stretching - During the stretch phase, a 
deformation is applied to the specimen. The 
deformation can be specified either in terms of 
force applied or displacement achieved.  

Holding - The deformation can be held for a given duration. The duration for which it is 
held is dependent on the nature of the testing. 

Recovering - The recovery phase is the time during which the force being applied to the 
specimen is removed. The duration of the recovery time is configurable and dependent 
on the nature of the testing. 

Resting - Finally, the rest phase is the time between the end of one cycle and the 
beginning of the next. Some tests may specify a short recover time, while others may 
specify a longer time. The duration is configurable and dependent on the nature of the 
testing. 

Control Modes 

There are two control modes which define the basic approach to a given test: displacement control 
and force control: 

Under displacement control, the displacement of the specimen is predefined. The 
UStretch stretches the specimen until the predefined displacement is achieved. The force 
required to achieve the displacement is an output of the test. 

Under force control, the force applied to the specimen is predefined. The UStretch 
stretches the specimen until the predefined force is achieved.  The displacement required 
to achieve the force is an output of the test. 
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Control Functions 

The UStretch makes it possible to test specimens under several control functions: 

Under displacement control: 

The true strain function applies the displacement at a true strain rate, which accounts for 
the current specimen length while the specimen is being stretched.  The UStretch system 
approximates this with a series of linear segments (default = 10).  

The ramp function applies the displacement at a constant nominal rate. This is equivalent 
to a constant engineering strain or constant velocity.  

The sine function applies the displacement according to a sinusoid with the desired 
displacement magnitude and duration.  The UStretch system approximates this with a 
series of linear segments.  

 

       True Strain          Ramp       Sinusoid             Custom     
 
 

Time 

Displacement             

 

Under force control: 

The step function achieves and maintains the desired force as quickly as possible. The 
amount of time it takes to achieve the desired force depends on the material being tested 
and the force control settings.   

 

       Step 
 
 

Time 

Force 
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3. Software Overview 

The software included with the UStretch device is called UStretch.  It is divided into two modules, 
a data collection module and a review and analysis module.  The data collection module is used to 
set test parameters, enable specimen loading and testing, and monitor test progress.  The screen 
layout for this module is shown below: 
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The review and analysis module is used to playback accelerated or decelerated test images, 
perform image analysis and tracking, and output movie files for presentation purposes.  The screen 
layout for this module is shown below: 
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Output Files and Data Structures 

For each test, the UStretch creates and saves three file types. The following table describes the 
three file types for a project named “Sample1”. Output from this test would be found in a “Sample1” 
output directory (a sub directory of the user specified data directory). 

File Type Description 

.tst file The Sample1.tst file that contains the exact protocol and settings used for the test. 

.csv file The Sample1Data.csv file that contains comma separated numerical data such as time, force and 
displacement values. 

.jpg files Captured images such as Sample1.000010.3.jpg, which would correspond to an image captured 
at 10.3 seconds from the start of the test. 

 

Each test folder will also contain 2 subfolders.  The “Logs” subfolder contains a text file of the 
content of the text dialogue portion of the main screen.  It is useful as reference to troubleshoot 
problems with your system, should they occur. 

The “Tracking” subfolder is initially empty.  If tracking is done on any of the images in the test folder 
using the “Analyze and Review” software module, there will be data files that contain the tracking 
information stored in this directory.   

While using the “Analyze and Review” software module, you may create additional data files such 
as text files (*.csv) containing tracking results, images with force data or tracking results overlaid 
(*.wmf), or movie files (*.avi).  These additional files can be stored in the test directory or elsewhere 
on your computer’s hard drive without interfering with the software application (once created, they 
cannot be opened by the UStretch application). 

When working with the data, you should be aware of a few details regarding the data output: 

1. The output specimen sizes are based on the spacing between the grips or BioRake tines 
and do not account for the specimen material outside of the test region. 

2. The software cannot calculate stresses since the thickness of the specimen is not known. 
To calculate stress, you will have to manually measure the thickness of the material before 
or after the test is performed. 

3. Strains can be calculated using the output displacement values (which are based on the 
grip or BioRake tine motions). The specimen may actually be subjected to less strain than 
the calculated values due to attachment site effects and tissue tearing. The image tracking 
module is useful for determining the actual strain values and variations within the 
specimen. 
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4. Setting Up & Starting a Test 

Overview 

Setting up and running a new test is a simple process made up of both mandatory and optional 
steps. The following list presents all of the steps, while the rest of this chapter describes each of 
the steps in detail. 

Step 1: Start a New Test 

Step 2: Reset the Actuator (occasional) 

Step 3: Move the Actuator to a Specified Size 

Step 4: Zero the Load Cell (occasional) 

Step 5: Modify the Test Parameters (optional) 

Step 6: Mount the Specimen 

Step 7: Execute the Test 

Step 8: Terminate the Test Prematurely (optional) 

Step 1: Start a New Test 

Launch the UStretch software, and then select Collect New from the File menu. In the Create Test 
From Template dialogue, perform the following steps: 

1. Select a template that matches the type of test you wish to perform. See the UStretch Tip 
on how to select and use a template. You can modify the template parameters in Step 5, 
below.  

2. Name your test. The dialogue will have a default test name. You can use the default or 
rename the test. Each time you start a new test, the default name will continue to increment 
the number at the end of the name. 

3. If desired, you can change the location of the output data. The location of your output data 
and images is determined by specifying a Test Name and Data Directory. The template 
and data directories are user specific (computer login name). Each system user can store 
their files to a different default location. The system uses the last location selected as the 
default. 

 

UStretch Tip: Selecting and Using Templates 

How to select a template: Designing an appropriate test sequence is an art that depends 
on both the type of material being tested and the specific material properties you are 
interested in measuring. When first testing a new material, you should expect to have to 
experiment with the settings until the test yields meaningful data.  

The system comes loaded with example templates to help you get started. Selecting a 
template does not lock you into a specific test sequence or protocol – rather a template 
defines a test sequence and settings, all of which can be changed before a test is run. 
Once you have developed a test sequence and settings that are appropriate for the 
material you are testing, you should save these settings using “Save As Template” from 
the file menu. You can then select your template the next time you initiate a test. 
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Step 2: Reset the Actuator (occasionally) 

While it is not necessary to reset the actuator with every test sequence, we suggest performing a 
reset at the start of a new test session. If you have stopped the previous test in mid cycle, then you 
should reset the actuator. By resetting the actuator, you are ensuring that the displacement 
measurements taken by the UStretch are accurate. 

To reset the actuator, select Reset Actuator from the tools menu, or press  on the toolbar. 

 

System Alert 

You should NOT reset the actuator if the specimen is already loaded. Doing so will 
damage your specimen and/or the load cell. 

Step 3: Move the Actuator to a Specified Size 

After the actuator has been reset, it will remain in the fully retracted position and must be moved to 
a specified (reference or starting) position.  

To move the actuator to the specified position, select Move Actuator to Specified Size from the 

Tools menu, or press  on the toolbar.  

Step 4: Zero the Load Cell (occasionally) 

While it is not necessary to zero the load cell with every test sequence, we suggest zeroing the 
load cell at the start of a new test session. With repeated use, the zero point of the load cell can 
drift. By zeroing the load cell, you are ensuring that the force measurements are accurate. 

To zero the load cell, select Zero Load Cell from the tools menu or press  on the toolbar. 

 

System Alert 

You should zero the load cell after attaching a BioRake or clamp but before mounting a 
sample. If a specimen is already loaded when the load cell is zeroed, the force reading 
will include an offset load. 

 

UStretch Tip: Zeroing the Load Cell 

The gooseneck attached to the load cell weighs a certain amount and will introduce forces 
on the load cell.  In the horizontal orientation, this is a bending force which will introduce 
a small negative offset in the force reading which must be zeroed out after the gooseneck 
is attached and the load cell is mounted to the frame.  Additional bending forces are 
introduced when a clamp is attached to the load cell gooseneck and must be zeroed out 
before mounting a sample in the clamp. 

In the vertical orientation (for instance, during calibration) an in-line force is produced by 
the gooseneck which introduces an offset proportional to the mass of the gooseneck.  
This must also be zeroed out beforehand to achieve an accurate calibration factor or 
accurate force reading during a test. 
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Step 5: Modify Testing Parameters (optional) 

You can select and modify parameter sets by clicking on 
a row in the Test Parameter Specification table and then 
pressing the Edit Set button (or by double clicking on the 
desired row). When you do so, the Set Parameter Editor 
Dialogue will appear.  

Note that displacements are specified in either % strain, 
or mm. Force loads are specified in N, and durations are 
specified in seconds. 

The following table describes each of the parameters. 
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Test Parameter Description 

Control Mode Tests are typically performed under displacement control, however, you can select the 
following control modes to achieve specific testing objectives: 

 For creep testing, use force control with a long hold duration. 

 For relaxation testing, use displacement control with a long hold duration. 

Control Function True Strain or Ramp is typically selected for tests performed in displacement control 
mode. For tests performed in force control mode, step controls are selected.  

Stretch Magnitude  
(Load Magnitude when in 
Force Control mode) 

Selecting a stretch magnitude is dependent on the material you are testing. A sound 
approach is to begin with a small magnitude and iteratively move up to larger magnitudes.  

If you are using Displacement control mode, you can specify the displacement in either 
µm or as a percentage. For example, the displacement on a 5mm specimen can be 
expressed as either 0.5mm or 10%. 

If you are using Force control mode, you can only specify the force in N. 

Watch the test results carefully to determine which magnitude setting best achieves your 
test goals. 

Preload Preload is typically reapplied on every repetition during a preconditioning set as well as 
on the first repetition of a testing set. Specimen size is adjusted after a preload 
adjustment. Strain calculations are based on the specimen size after the last preload 
adjustment.  If you are working with a material for which preload values have been 
suggested, you can set the value accordingly. Otherwise, zero is a good initial choice. 

Preload Magnitude As with stretch magnitude, the preload magnitude settings depend on the material you 
are testing. While Preload can be set at zero, typically you would set the preload 
magnitude somewhere between zero and 10% of the peak load you expect to achieve. 

Stretch Duration For evenly spaced images, it is recommended to choose a number that is an integer 
multiple of the Image Output Frequency. 

Hold Duration Hold Duration is typically set to 0, however it is useful for creep or relaxation testing. 

Recovery Duration Recovery Duration is typically set to the same value as the Stretch Duration. 

Rest Duration Rest duration is typically set to 0, however a non-zero value may be used to mimic in 
vivo conditions or for specialized testing. 

Repetitions Apply enough repetitions until the force deformation curves from one repetition to the 
next start to overlie each other. 

Data Output Frequency Typically set to the same frequency as the image output frequency. 

Image Output Frequency Typically set to 1Hz for cycles > 5 seconds and 10 Hz for cycles < 5 seconds. 

 

UStretch Tip: Idle Current 

Idle current (holding current) can be applied to the motors.  The motors have a holding 
force in the de-energized state of approximately 10N.  If forces in excess of 5N are 
expected it is recommended that idle current is used to prevent position loss during 
velocity and direction changes when the motors are de-energized for a very short time.  
When idle current is activated the motors will produce more noise, even when the 
actuator is at rest. 
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Step 6: Mount the Specimen 

BioRake Mounted Specimens 

Proper specimen mounting is critical to ensuring accurate and repeatable results. It is best to have 
the tines spaced evenly across the edge of the specimen and as closely to the edges as possible. 

To mount the specimen, follow these steps: 
1. Input a specimen size, and from the tools menu, select Move Actuators to Specified Size, 

or press  on the toolbar. 

2. Place the specimen on the rake mounting block on top of a backing material such as soft 
silicone or foam. 

3. Partially raise the UStretch main unit. 

4. Place the mounting block underneath the 
BioRake tips. 

5. Centre the specimen between the rakes using 
a small implement, such as forceps, and the 
live video window as feedback. Adjustment of 
the actuators may be necessary to ensure the 
rake tines are positioned correctly for non-
ideally sized specimens. 

6. Gently lower the UStretch main unit so that the 
rake tips are in contact with the specimen.  It 
may be necessary to prop up the main unit 
slightly based on the thickness of the backing 
material and sample. 

 

7. Push all 10 tines into the specimen, either all at 
once using a press block or one at a time using 
a small implement such as a precision 
screwdriver. 

8. Partially raise the main unit and remove the 
backing material.   

9. Put the fluid bath in place, if desired.  Typically, 
you will want to match a specimen’s 
physiological state, which for most biological 
materials is in a saline solution heated to the 
organism’s body temperature. 

10. Fully lower the main unit. 
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UStretch Tip: Ideal Specimen Size 

The UStretch is designed for small specimen sizes. For our Standard BioRakes (5 tines 
spaced at 1 mm) the ideal specimen size has ends with lengths of 5.5 - 6 mm. If a 
specimen is not in the ideal range, it may still be mounted, but the placement of the rake 
tips will need to be adjusted.  

Manual adjustment of rake positions during specimen loading may be necessary to 
ensure that the rakes puncture the tissue correctly. 

These manual adjustments result in a change in specimen size, which in turn results in a 
change in actuator displacement profiles. The specified specimen size is displayed at the 
top of the screen while the current specimen size is displayed on the left of the screen 
just below the force output.  

At any point before the test has started, specimen size can be changed using one of the 
following methods: 

 Press  on the tool bar, or from the Tools menu select Move Actuators to 
Specified Size 

 Use the Actuator Control jog button 
arrows. 

 
 

 

 

Clamp Mounted Specimens 

To mount the specimen, follow these steps: 
1. Input a specimen size, and from the tools menu, select Move Actuators to Specified Size, 

or press  on the toolbar. 

2. Place the specimen on the clamp mounting block. 

3. Slide the jaws of the clamp onto the 
specimen, tighten the clamp using the 
appropriate hex key 

4. Place the clamp on the load cell 
gooseneck 

The clamp being placed on the force-
measuring side should not be tightened 
when in place on the gooseneck to prevent 
off-axis loads and subsequent damage to 
the load cell. 

5. Place the other clamp on the actuator 
gooseneck. 

6. Slide the specimen between the jaws of 
the clamp and tighten the clamp using 
the appropriate hex key. It may be 
necessary to jog the actuator to the 
appropriate size.  
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7. Partially raise the main unit and put the 
fluid bath in place, if desired. 

8. Fully lower the main unit.  

  

 

 

UStretch Tip: Zeroing the Load Cell 

Additional bending forces are introduced on the load cell when a clamp is attached to the 
load cell gooseneck and result in a force offset which must be zeroed out before mounting 
a sample and starting a test. 

 

Step 7: Execute the Test 

Select Execute from the File menu, or press  button on the toolbar. 

Step 8: Terminate the Test Prematurely (optional) 

You can stop a test at any time by pressing  on the toolbar, or by selecting Stop from the File 
menu. This is preferred over powering down the equipment, as it allows the software to store the 
current actuator position and eliminates the need to reset the actuators on subsequent tests.  

At the end of the completed test (both normally or prematurely terminated) the actuators will 
maintain their current position.  

 

UStretch Tip: Specimen Thickness 

Measuring the specimen thickness before and/or after a test is performed will allow stress 
calculations to be made from your output data. 
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5.  Additional Settings 

Configuring Output Data Files 

From the Settings menu, select Data Output to display the dialogue shown on the left. Click the 
Configure button to select which of the following columns to output. 

 

 

 

 

Output Column Description 

Set Name  User defined name of each set 

Cycle Cycle and Phase information 

Time (S) Time in seconds 

Size (mm) Specimen Gage Length 

Force (N) Load Cell reading 

Displacement (mm) Reports the change in size relative to the initial size 

Set Name Name specified for each set 

Temperature (°C) Current temperature 
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Advanced System Settings Dialogue 

Advanced settings are available by selecting Advanced from the Settings menu.  All of these 
settings are template specific. 

True Strain Rate 

Unlike nominal or engineering strain 
rate, a plot of velocity versus time for a 
true strain rate test would be non-linear. 
The degree of non-linearity increases 
with increasing strain. The UStretch 
approximates this non-linear curve with 
a series of linear segments. Typically, 
10 line segments is a sufficiently close 
approximation. More segments can be 
used, but you should bear in mind that 
the actuator velocity can only be 
updated every 250ms. 

Data Averaging 

The load cells are sampled at 100Hz 
with hardware using a central moving 
average of 8 samples. Further data 
averaging can be applied to smooth 
noisy data. 

Force Control Settings 

Force Control Settings affect the rate 
and stability at which forces are 
achieved.  These settings apply to 
preloading as well as Force Control 
Modes. 

 

 

Kx (Default = 100, integer values) is a proportional gain tuning parameter.  It controls the 
sensitivity or the amount of corrective action that is applied to the difference between the 
current and target force values.  At low gain values the system may be safe and stable but may 
be sluggish in response to changing conditions.  If the proportional gain is increased the system 
becomes more responsive and loads are achieved more quickly.  If Kx is set too high, an 
unstable oscillating system may result and forces may never be achieved. The optimal value 
for these settings depends on the properties of the material being testing.   For stiff tissues 
values may range between 1 and 10.  For soft tissues values may range between 50 and 200.  

Tolerance (N) (Default = 0.01) controls how close to the specified force the actual load values 
need to be. For example, a specified force of 0.1N with a Tolerance of 0.003 N will be 
considered achieved when the loads are between 0.097 and 0.103 N.  Keep in mind the 
tolerance of the load cell being used when choosing the value for this parameter.  The load 
cells typically fluctuate by about 0.1% of their full scale during the course of a test.  For a 1N 
load cell this is about 0.001N but for a 23N load cell, this is about 0.023N.  This value should 
usually be 0.2-0.5% of full scale to ensure stable operation. 

Settling Frames (Default = 5) controls how many successive load samples (sampled at 100 
Hz) need to be within the Tolerance criteria for the force to be considered achieved. For 
example, a specified force of 0.1 N with a Tolerance of 0.003 N and Settling Frames = 5 will 
be considered achieved when the loads are between 0.097 and 0.103 N for 5 successive data 
samples at 100 Hz. 
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Velocity (1-10 integer values) matches actuator jog speed.  Typically for harder tissues, this 
value should be between 4 and 6 and for soft tissues, this value should be between 6 and 10. 

Acceleration (1-10 integer values). Typically, this should be set to the default value of 10 
(maximum acceleration).  Changes made to the acceleration will affect tests under both force 
and displacement control.  Reducing this value may help smooth force controlled tests under 
low loads or displacement controlled tests at high speeds.  Tests run with lower accelerations 
will have softer transitions at direction or speed changes but may take longer than specified to 
achieve testing cycles. 

 

UStretch Tip: Testing Force Control Settings 

It is important to have appropriate Force Control Settings that match the materials you 
are testing.   

To safely test Force Control Settings:  press  
on the tool bar, or from the Tools menu select 
Move Actuators to Specified Load.  The dialogue 
shown on the right will appear.  The UStretch will 
attempt to achieve the specified load (force) but 
will stop when the specified load is reached, the 
actuator has displaced by the maximum specified 
amount, or the timeout time has elapsed. 

If the actuator oscillates around the specified 
loads but never achieves them try reducing Kx 
and/or decreasing the velocity. 

 

If the actuator reaches the specified load too 
slowly, try increasing Kx and/or increasing the 
velocity. 

 

 

 

Reset Actuators 

Resetting the actuators with a sample attached may damage the specimen, BioRakes, and/or 
load cells.  To avoid resetting the actuators with a sample attached, a warning dialogue will 
appear after “Reset Actuators” is selected, prompting the user to proceed.  This feature can be 
disabled by de-selecting “Show Warning Before Resetting Actuators”. 
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Range Limits 

Range limits can be accessed by selecting Range Limits from the Settings menu.   

Soft Limits 

To avoid rake collisions or sample 
destruction, it is useful to assign 
reasonable travel limits to the 
actuators. This is especially important 
during force control or preloading, 
where if specified loads cannot be 
reached, the actuators will keep 
moving until they reach the soft limits. 

Min and Max Displacement, in mm, 
set the minimum and maximum 
positions to which the rakes are 
allowed to move. 

Max Force, in N, sets the maximum 
value of force at which a test will be 
automatically stopped.  The default 
value is set to the capacity of the load 
cells.  Setting this value may be useful 
to prevent sample destruction or 
overloading of the load cells. 
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Configuring the Live Charting Graphs 

The three graphs on the right side of the screen 
provide real-time user feedback during a test. 
These graphs are intended to be used for 
qualitative feedback, not for detailed analysis.  

The graphs are updated at a maximum 
frequency of 10Hz; certain short-duration tests 
may not show all the detail that is actually 
present.  

The graph settings can be specified by selecting 
Graphs from the Settings menu. Auto scaling 
allows the axis min and max to start at the 
specified values but expand if the data values 
are larger or smaller than the initial limits. 

 

 

  



UStretch User Manual 

22 

 

 

Graph Data 

Force versus Time 

This graph shows how the measured forces are 
changing with time. Peak loads per cycle and force 
relaxation are all easily seen in this type of graph. Force 
is proportional to nominal (engineering) stress. 

 

Displacement versus Time 

This graph shows how the rakes are moving with time. 
The phases of the test sequence and size adjustments 
due to preloading are readily apparent in this type of 
graph. 

 

Force versus Displacement 

This graph displays a qualitative representation of the 
material behavior. Viscoelastic effects (like hysteresis) 
and material response to different loading phases are 
apparent in this graph. This graph is proportional to a 
nominal (engineering) stress-strain graph. 
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6. Reviewing Test Results 

Overview 

The UStretch software has an integrated image analysis module which can be accessed by 
selecting Analyze and Review Images from the file menu, then selecting the appropriate test file.  
The test file is a text file with a .tst extension that contains information about the test parameters 
so that the software can display the images and data in a useful fashion. 

 

 

Image 
List 

 

 

 

 

 

Image 
Playback 

 

 

Image 
Tracking 

 

 

 

Data 
Overlay 
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Selecting Images 

The Images are shown in a tree structure on the top left panel. 
The tree structure organizes the images by: 

Set (line on the test parameter window) 

Cycle (iteration of a given Set) 

Phase (Preload/Stretch/Hold/Recovery/Rest of each Cycle) 

Image (the one or more individual images from each Phase) 

You can select which images to include in a playback set in one 
of several ways: 

 hold down the shift key and click on individual images 

 select entire sets, cycles, or phases (will playback all 
contained images) 

 select images which have data associated with a 
particular tracking set 

 

Image Playback Options 

The controls on the left of the screen are broken into 2 sections: 
Playback and Tracking.  

The playback buttons allow the user to review the images taken during 
a test. 

 

Next/Prev Display next or previous image (as dictated by “Play Every” parameter). 

Play/Stop Start and stop the playback. 

Prev/Next Cycle Jumps to a corresponding image and phase in the next or previous cycle. Useful when reviewing 
sets that have multiple cycles. 

Loop Sequences can be played continuously in a loop or only once. 

Playback Rate +/- changes the speed of the playback. A playback rate can also be manually entered in the display 
box. 

Play Every Allows the users to skip some frames to expedite playback. 
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Image Tracking: Overview 

Image tracking is a function that can be used to quantify the 
motions of image features (rake tines, specimen texture and 
fiducial markers). This can be useful for studying localized 
specimen deformations, determining or verifying strain 
magnitudes, and comparing the results of one test to another.  

The image tracking engine is based on a template matching 
algorithm. This algorithm starts by defining a “patch” of pixels 
(called a template) surrounding the selected source point on the 
source image. It then determines the optimal location for this 
template on a target image within a specified search region.   

The algorithm defines the location of the tracked point on the target image as the center of the 
optimally located template.  

To track an image, follow these steps: 

1. Click the Create button in the 
tracking window, shown above. 
This brings up the Tracking Editor 
dialogue box. 

 

2. Enter a Tracking Name. 

3. Select the Source Image in the test 
image list tree, and click Set to the 
left of the Source box. 

4. Select the Target Images in the 
test image list tree, and click Set to 
the left of the Target box. The 
target image list will automatically 
be sorted to remove duplicates 
and be put in sequential order. 

5. Generate source points on the 
source image by performing the 
following steps: 

a. Manually click source point 
locations on the source image 

 with the Add button depressed. 

b. Draw a box on the source image with the Select button depressed, then click the Grid 
button and define a grid of points. 

The displayed image will automatically change to the source image when either the Add 
or Grid buttons are depressed. 
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6. Modify search parameters: 

Source 
Template 

The optimal source template is difficult to predict, but in general it is 
advantageous for the template to be large enough that it contains at 
least one feature, but not so large that it contains multiple features.  
Typical values for this parameter are between 15 and 55, with 35 
being a good starting point for most situations. 

Search Region The search region needs to be large enough that the optimal location 
for the template is found. In general, no part of the specimen moves 
more than the rake tines, so the motion of the rake tines is a good 
guideline for how large the template needs to be.  For example, if the 
rake tines move 50 pixels over the 10 frames you are interested in, 
it is unlikely that any part of the specimen is moving more than 5 
pixels/frame and so a good value for the search region parameter 
would be 11 (5 pixels each way, plus the center pixel). 

Use Source 
Template From 

First Image tracks all images against the first in the series (1→2, 
1→3, 1→4…). 

Previous Image tracks each subsequent image against the image 
before it (1→2, 2→3, 3→4…). 

First Image Tracking tends to have poorer correlation than Previous 
Image Tracking because the current image is usually closer in 
content to the previous image than it is to the first image in the 
sequence. Previous Image Tracking tends to have good correlation 
for each individual step, but is prone to error accumulation since 
each step is independent. The best method for a given data set will 
depend on the number of images and the content of the images.  
Sometimes it is best to use Previous Image Tracking but to only use 
every other image or every n’th image rather than all the images 
available. Sometimes it is best to use First Image Tracking and use 
every image but set the source image in the middle of the image 
series rather than at the beginning.   

Set Search 
Region Centre 

New Point Locations The location of the center of the search region 
is set to the same location of that point in the previous image (even 
when the source template is from the first image). 

Existing Point Locations The search region center location is set 
to the previously tracked location of that point. When no previously 
tracked point exists, the location is chosen in the same way as New 
Point Locations.  

Use Strain 
Based 
Deformable 
Templates 

When this option is checked, the source template will be scaled 
(resized) according to strains calculated from the test XSize 
parameters. Best tracking results are often obtained when using this 
option. This option may not be the best for tests where the specimen 
deformation is non-uniform. 

7. Perform tracking with either Track All Points or Track Selected Points. 
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Image Tracking: The Points Display Option 

The Points Option displays the points in their current 
location (i.e. their location on the currently displayed 
image) with or without gridline connecting points that 
were generated using the grid function.  

Clicking the details icon brings up the window shown to 
the right. Options include changing the point radius or 
color, showing ID numbers and showing gridlines with or 
without ID numbers.  

Gridline ID numbers are associated with each grid square 
(cell), while Point ID numbers are associated with the 
points themselves. 

Tracking display settings default to the last used settings. 

 

 

Figure 1: Initial tracking grid displayed as points. 

 

Figure 2: Tracking to 50% strain displayed as 
points. 
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Image Tracking: The Displacement Option 

The Displacement Option displays the points in their 
current location as well as graphically representing their 
motion through time.  

Clicking the details icon brings up the window shown to 
the right. This dialogue allows the user to change the 
reference image, change the type of connecting line, and 
change the line appearance.  

Displacement connecting lines directly connect the 
reference and current points via a vector or a path. The 
path option provides more information but can result in 
slow playback speeds for sets with many points and/or 
many images.  

The Flow option generates a direction vector based at 
the current location and oriented in the direction of 
motion relative to the reference image. This can be 
useful because the length of this vector can be scaled to 
better visualize small displacements. 

Tracking displacement settings default to the last used 
settings. 

 

 

 

 

Figure 3: Tracking to 50% strain displayed as displacement. 
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Image Tracking: The Strains Option 

The Strains Option can only be used in conjunction with a grid 
of points (as opposed to individually placed points). This option 
calculates the regional strains inside every grid box and 
displays this data as an ellipse. One can imagine this is what 
would happen to a grid of circles drawn on the surface of the 
specimen at the beginning of the test. 

Clicking the details icon brings up the window shown to the 
right. This dialogue allows the user to change the reference 
image as well as the appearance of the circles and text.  

Showing text for E1, E2 (principal strains) will result in the text 
showing the strains along the major and minor axis of the 
ellipse. Showing text for Ex, Ey will result in text showing the 
strains along the X and Y directions regardless of the ellipse 
orientation. 

Tracking strain settings default to the last used settings. 

 

 

 

 

  

  

 

 

Figure 4: Tracking to 50% strain displayed as strain ellipses with text showing x% strain. 
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Data Overlay 

Data associated with each image is displayed below the 
tracking controls on the left side of the main window.  
Checking the Show Graph box displays this data as a 
graph overlaid on the images 

 

 

Clicking the details icon displays the window shown to 
the right. The dialogue allows the user to change the size 
and appearance of the overlaid graph. The data points 
associated with the current image are marked on the 
graph with green circles. The overlaid data graph will be 
drawn on top of any image tracking displays (when they 
overlap). 

Data Overlay settings default to the last used settings. 

 

 

 

 

 

 

Figure 5: Tracking to 50% strain with overlaid force graph. 
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Exporting Tracked Data 

Tracked grid point coordinates and calculated grid 
strains can be exported to a .csv file. From the Export 
menu, select Data Points to display the dialogue shown 
on the right. The image list is automatically set to the 
currently selected images in the test image list tree.  This 
image list can be changed by selecting new images in 
the test image list tree and pressing the set button. When 
exporting Strains data from Selected Tracking Points, all 
four points of a grid cell need to be selected for data from 
that cell to be exported. 

Exported data is labeled with associated ID numbers 
(grid point ID numbers for exported coordinates and grid 
cell ID numbers for exported strain values).  To display 
ID numbers on tracking grids see Image Tracking: The 
Points Display Option.  In the following example (Figure 
9), grid point ID numbers are shown in yellow and grid 
cell ID numbers are shown in white. When exporting 
data for the selected points as shown in red (see below 
image), coordinates are exported for points with ID 
numbers 5, 6, 7, 8, 9, 10, 11 and 12, and strains are 
exported for grid cells with ID numbers 4, 5, and 6. 

The exported .csv file is written to the test directory. 

 

 

 

Figure 6: Tracking Grid showing ID Numbers. 

 

Figure 5: Sample Exported Data. 
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Exporting Images and Movies 

The current Image view, including all displayed tracking 
grids, tracking data and overlaid data can be exported 
as a metafile by selecting Current Image from the Export 
menu.  Alternately, the current image view can be copied 
to the clipboard by selecting Ctrl-C from the keyboard. 

To export a series of image views, including all displayed 
tracking grids, tracking data and overlaid data as a .avi 
movie, select Movie from the Export menu.  The 
dialogue shown on the right will be displayed.  The image 
list is automatically set to the currently selected images 
in the test image list tree.  This image list can be changed 
by selecting new images in the test image list tree and 
pressing the set button.   Options are available for setting 
the frame rate or image size (resolution), adding 
filenames, and choosing color or grayscale output.  
Compression options are also available. 
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7. System Hardware Settings 

Controller 

The UStretch uses an integrated control board rather 
than a group of PC controlled device drivers. This 
minimizes communication lag and allows the device to 
operate asynchronously with the PC. The control board 
details can be seen by selecting Hardware from the 
Settings menu, which brings up the window shown to the 
right. 

 

 

 

Camera 

The camera uses a ½” monochrome CCD sensor to 
obtain a resolution of 1280 pixels by 960 pixels. The 
camera shutter can be controlled during the setup phase 
of the test. 

The camera captures images at 15 frames per second 
during every test and writes these images to a buffer. 
The test controller extracts images from this buffer at the 
frequency specified in the Set Parameter Editor (15Hz, 
5Hz, 1Hz, 0.1Hz, 0.01Hz, or 0.001Hz). These images 
are written to the output directory. The file name is the 
ideal capture time. The actual capture time may differ 
from the ideal capture time by as much as 1/30 of a 
second since the images are extracted from a buffer.   

The test software creates an image capture log file in the output directory should this difference 
be significant. This log stores the actual capture time and the idealized capture time. 

The camera default shutter and gain are specific to each test template and can be set by selecting 
Hardware from the Settings menu. The recommended maximum shutter speed is 10mS.  
Typically, the camera iris is left fully open and the shutter and gain are adjusted to achieve the 
desired image brightness. 
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Load Cell 

The load cell is semiconductor strain gage-based with 
high overload capacity. It has an accuracy equal to 0.2% 
of the rated full scale load. The load cells are available 
in 0.5N, 1N, 2.5N, 5N, 10N, 23N, and 45N sizes. Each 
load cell has a unique calibration factor which is stored 
in a chip attached to the load cell connector. 

While the load cells should not have significant 
hysteresis or thermal drift, temperature changes or 
prolonged loading can introduce small offsets.  In 
addition, the bending force from the weight of the 
gooseneck and clamp can introduce a small offset in the 
load cell reading. It is recommended that the zero load 
state be redefined before beginning a test. This can be 
done by selecting Zero Load Cells from the Tools menu 

or pressing . 

 

The load cells are sampled at 100Hz, with hardware providing 8 sample averaging to reduce noise 
in the data. Further sample averaging can be implemented by selecting Advanced from the 
Settings menu. 

Each load cell is calibrated and has a specific calibration factor which is stored on a chip in the 
load cell connector.  Field calibration using the provided test weights is recommended (see 
Section 8).  The range and calibration factor can be viewed by selecting Hardware from the 
Settings menu, but are not user controlled. 

Actuator and Motor 

The actuator is driven by a stepper motor under open 
loop control. The motor drives a lead screw attached to 
a stage that the gooseneck is mounted to.  The stage 
has a peak velocity of 50mm/s. Provided that the 
actuator is not driven beyond its rated velocity and thrust 
load, the stepper motor is very unlikely to lose steps. To 
prevent excessive velocities and accelerations, the 
control software will issue warnings if entries in the Set 
Parameter Editor result in accelerations or velocities that 
are out of range. Excessive thrust loads should only 
occur if mechanical interference from the fluid chamber 
or a foreign object obstructs the movement of the 
actuator. It is advisable to reset the actuators 
occasionally. 

 

Idle current (holding current) can be applied to the motors.  The motors have a holding force in 
the de-energized state of approximately 10N.  If forces in excess of 5N are expected it is 
recommended that idle current is used to prevent position loss during velocity and direction 
changes when the motor is de-energized for a very short time duration.  Turning idle current on 
may produce smoother motions in force control (since the motors are frequently stopping and 
starting). When idle current is activated the motors will produce more noise, even when the 
actuator is at rest. 
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Temperature 

To activate the fluid chamber heater, both power 
switches on the front of the UStretch control box need to 
be in the On position (the computer and software do not 
need to be on yet). At this point, the heater will warm the 
fluid to the last used temperature set point. The 
temperature set point can be changed by selecting 
Hardware from the Settings menu.  

Typically, the heater will take 30-60 minutes to warm a 
full fluid chamber from room temperature to 37°C. 

When Show Temperature Warnings is enabled and the 
Current Temperature is not at the Temperature Set Point 
plus or minus the specified tolerance -- a red indicator 
button will be displayed next to the Current Temperature 
live output and a warning dialogue will appear when you 
execute the test. 

 

 

System Alert 

In the event of a dislodged or faulty temperature sensor, or if there is a lack of fluid in the 
fluid chamber, the system is designed to reach a maximum temperature of 70°C. 

 

 

 

Caution: Avoid touching the base plate surface below the fluid chamber when the 
heater is on, it can become very hot! 

 

UStretch Tip: Preheat Fluid 

You can add preheated fluid to the fluid chamber to reduce warm up time. 
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8. System Calibration and Advanced Tools 

Load Cell Calibration 

If the load cells are changed or moved, it is advisable to perform the load cell calibration routine. 

Before installing a load cell, select the appropriate gooseneck. Use the stainless steel gooseneck 
for the 1N, 2.5N, 4.5N, 8.9N, 22N, and 44N load cells. Use the black plastic gooseneck for the 
0.5N load cell. Do not use the stainless steel gooseneck with a 0.5N load cell as the weight of the 
gooseneck alone will overload the load cell. After selecting the appropriate hardware, proceed with 
these steps to calibrate the load cell: 

 

This calibration can be performed in the following steps: 

1. Reset the actuator  

2. Place the unit in the vertical orientation.  

3. Zero the load cell    to remove the weight of the gooseneck from the calibration values 
measured. 

4. From the Tools menu select Advanced then select Load Cell Calibration  

 

 

 



UStretch User Manual 

37 

 

5. Measure the zero load condition for the first calibration point (no calibration weight) 

a. Enter “0” in the “Enter Weight” dialogue 

b. Click “Read” 

6. Measure one or more known weights in the same manner as above.  Hang the weights 
from the upper gooseneck using the supplied calibration test weights.  Centre them on the 
load-bearing surface to ensure in-line loads and use weights corresponding to the load cell 
capacity range.  Do not overload the load cell. 
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7. Click “Run”. 

8. Click “Apply” 

9. Click “Done” 

 

Note: Only take one reading per calibration weight used.  Multiple readings of a single load 
value can cause an error in the calibration algorithm  

Be sure to re-zero the load cell in the horizontal testing position before running a test in this 
orientation 

 

UStretch Tip: Calibration Factor 

The relative calibration factor that is displayed in the main dialogue box at the end of the 
calibration procedure is the ratio of the current calibration value to the previous calibration 
value.  If there has been no change to the load cell, this should be between 0.99 and 
1.01. 

The absolute calibration factor is the actual calibration factor in mV/V.  This is typically 
between 20-40.  If this is not the case, perform the calibration again or call the 
manufacturer for assistance. 
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Zero Position Calibration 

The actuator position is indicated in the “Current Size” dialogue on the left-hand side of the screen.  
This is the current separation of the BioRake tips or the front edge of the clamps.  In order for this 
measurement to have meaning, a zero position must be defined.  This is a position where the 
BioRake tips just overlap or the clamp tips would just touch each other.   

The “Move to Size” command is also dependent on a correctly defined zero position.  

The actuator zero position is preset at the production facility before the UStretch unit is shipped.  
However, if the actuator zero position has been incorrectly reset or if the goosenecks or load cell 
has been changed, a zero position calibration must be performed. 

 

1. Select the reset actuators button  (or use Tools>Reset Actuators). 

2. Place a BioRake on each gooseneck. 

3. Using the actuator jog control arrows at the lower left of the screen, manually move the 
actuators until all 10 BioRake tips are collinear.  The camera view can be used to provide 
a close-up of the rake tips for this procedure.  Note that it is the tips of the BioRakes that 
should be collinear and not the outside edge.  Because the tips are underneath the 
BioRakes and cannot be seen on screen, it is necessary to estimate their position.  Please 
use the images below as a reference: 
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Example 1: BioRakes have too much overlap. 

 

Example 2: BioRakes are correctly positioned. 

 

Example 3: BioRakes do not have any overlap so tips are not collinear. 
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4. From the Tools menu select Advanced and select Zero Position Calibration.  This should 
bring up this dialogue box: 

 

 

 
5. Press YES. 

6. Select the reset actuators button  (or use Tools>Reset Actuators). 

 

To check the zero position calibration, use the Move to Specified Size command .  Enter 
Specified Size = 0mm for this step. 

 

 

 

A warning dialogue will appear.  Select YES. 

Place a BioRake on each gooseneck and compare the position of the rakes to the image in step 3 
above. 

After a successful zero position calibration, the actuator can be successfully moved to a given 
sample size before beginning a test (for example, 5mm). 

 

Snap Image Feature 

Located under >Tools>Snap Image 

This feature allows the user to capture a single image during the setup phase.  This can be useful 
for documenting specimen loading activity and neutral (non-contact) beam position.  
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Adjusting the Camera Position and Image Magnification 

 

The UStretch comes equipped with a 10X zoom lens as shown below. Other versions of the 
UStretch may be equipped with a fixed magnification 50mm or 75mm focal length lens (see 
Appendix D instead). 

The image magnification and focus can be changed by rotating the adjustable rings found on the 
lens. Once the rings are adjusted to the desired settings, they can be locked using the thumb 
screws. Adjusting the three rings have the following effect: 

 
1. The iris ring changes the brightness 

of the image. It is recommended to 
leave this ring fully open and control 
image brightness by adjusting the 
camera shutter and gain in the 
Camera tab of the Hardware 
Settings. 

 

2. The W – T ring changes the 
magnification of the lens. 

 
 

3. The F – N ring changes focus of the 
lens. 

 

 

 

Using this lens, it is possible to achieve a wide range in the field of view as shown in the graph 
below.  Possible values for field of view are shown by the shaded gray region of this graph and can 
range from 5.5mm to 24mm.  The smallest fields of view are achieved at shorter working distances 
(that is, the camera is closer to the specimen).  To adjust the camera position, adjust the screws 
on the camera mounting brackets. The ideal distance from the specimen to the lens is 15cm. It is 
not recommended to have the lens any closer than this. 
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Temperature Sensor Calibration 

1. With the UStretch connected to the PC and turned on, launch the temperature calibration 
software located in the Windows start menu under UStretch>Utilities. 

2. Click the “Connect” button to establish communication between the software and the 
temperature controller.  The dialogue box should read “Digital temperature sensor in use”. 

3. Click the “Defaults” button to load the default control parameters from the temperature 
controller. 

4. Click the “Set Parms” button to assign the on screen parameters. 
5. Click the “Program Flash” button. 
6. The digital temperature sensor and temperature control parameters are now calibrated. 
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Update Firmware 

1. With the UStretch connected to the PC and turned on, launch the firmware update software 
located in the Windows start menu under UStretch>Utilities. 

2. Load the desired firmware file using the “Load Update File” button. 
3. Click the “Connect” button. 
4. Execute the update using the “Update” button.  This process can take many minutes to 

complete. 
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9. Troubleshooting 

 

Image Appears Out of Focus 

With the live image on the screen, adjust the lens focus until the image appears to be in focus.  

Whenever you adjust the focus, the image magnification may change slightly. If you want to know 
the absolute scale of your Images you can snap an image of a calibrated target (such as a precision 
graticule or ruler) by selecting Snap Image from the Tools menu. You can estimate the image scale 
by comparing the number of pixels between rake tips in the images with their known µm spacing 
(size) in the data output files.  

 

Communication Errors: ReadFile failed with error 6. 

When communication errors occur the live message window will display a ReadFile failed message. 
Communication errors can occur if: 

 The UStretch is not powered up. 

 USB cables between the computer and UStretch are disconnected. 

 The supply power surges or is interrupted.  

When a communication error occurs, close UStretch software, check connections, power cycle the 
UStretch Device, and restart the UStretch software.   

 

UStretch Tip: Preventing Power Disruptions 

We recommend plugging the UStretch (and host computer) into an uninterruptable power 
supply (UPS) or battery back-up. 
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10. Appendix A: Unpacking and Initial Setup 

Step 1: Unpack all components and have them ready for 
assembly. 

 

 

Step 2: Remove the cover from the main unit. 
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Step 3: Attach the load cell and replace the cover.  

Refer to Appendix C for more details on this procedure.  

 

Step 4: Attach the imaging system. 

Slide the main post holder over the positioning rail and tighten with the finger screw.  Attach the 
post riser to the camera bracket and slide the post in the post holder.  More information on adjusting 
the camera position and magnification can be found in Section 8 of the User’s Manual.  Two 
different post sizes are included to accommodate various camera offsets. 
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Step 5: Position the fluid bath and temperature sensor. 

Put the fluid bath in place.  Insert the temperature sensor in the sensor pocket.  Excess cable can 
be fastened with the included plastic C-clamp. 

 

 

Step 6: Attach the light source. 

An LED lamp is included for specimen imaging.  It is USB powered and can be clamped to the 
UStretch base or lab bench. 
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Step 7: Connect the controller to the test unit. 

3 connections are required: one for the main unit (large circular connector to the main unit), one for 
the heater (small circular connector to the black base plate), and one click connector for the 
temperature sensor. 

 

 

Step 8: Install the UStretch software. 

See Appendix B of the User’s Manual for more information. 

 

Step 9: Connect the UStretch controller and camera USB cables 
to the PC, connect the power cable 

A 48V brick power supply powers the UStretch system via a barrel connector on the front of the 
control box.  The UStretch controller and camera are connected to the PC via individual USB 
connections. A third USB connection may be needed to power the LED lighting system. Connect 
the USB cables and power on the UStretch unit. 

 

Step 10: Launch the software and begin a test to ensure the 
device loads up normally. 

 

Step 11: Calibrate the Load Cell 

See Section 8 of the User’s Manual for more information. 
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Step 12: Begin Testing 

It is recommended that the User’s Manual be thoroughly reviewed before beginning testing using 
the UStretch system.  Procedures for loading samples, setting up tests, carrying out tests, and 
reviewing results are described in detail. 
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11. Appendix B: Software Installation 

A Windows based PC (Windows 7 or above) with at least 2 USB ports is required to operate the 
UStretch.  A label on the cover of the manual contains a web address to download the UStretch 
software installation package.  These files contain the software installer for the user interface and 
control software for the UStretch.   

To install the software, go to the provided web address and download the compressed installation 
package.  Transfer this file to the computer which will be running the UStretch.  Right click on the 
file and select “Extract All…” to unzip.  After this is complete, go to the uncompressed installation 
folder and select “setup.exe”.  Details of typical dialogue boxes are shown below. 
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12. Appendix C: Load Cell and Gooseneck 
Installation 

Start by removing the main cover (9 x M3 counter-sunk screws) 

Attach the Load Cell to the Gooseneck and the Main Body 

Ensure the correct orientation of the load cell and tighten the screws gently to avoid damaging the 
load cell (a bit tighter than finger tight).  Ensure the load cell is angled as shown, the “measuring 
end” is connected to the gooseneck, and the fasteners attached in the correct order and position 
(see below images). Use the appropriate gooseneck the load cell being used (black plastic for the 
0.5N load cell, stainless steel gooseneck for 1N, 2.5N, 4.5N, 8.9N, 22N, 44N load cells.) 

 

 

Load cell female threads are 2.8mm deep 
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First select an appropriate gooseneck. Use the stainless steel gooseneck for the 1N, 2.5N, 4.5N, 
9N, 22N and 44N load cells. Use the lighter black plastic gooseneck for the 0.5N load cell. 

The load cell should be rotated about 30⁰ away from the user (see above) to properly stabilize the 

gooseneck yet avoid interference with the cable from the UStretch cover. Also, the Futek symbol 
(black background) on the load cell label is the “measuring end” and should be attached to the 
gooseneck and not the main body.  Reversing the orientation can introduce offsets in the force 
data. 

 
 

4-40 x 3/8” socket 
head cap screw 

4-40 x 5/16” 
socket head cap 
screw 
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Attach the gooseneck to the load cell using the 4-40 x 5/16" fastener and the 3/32” hex key.  Insert 
the hex key through the access hole to tighten the load cell to the UStretch main body using the 4-
40 x 3/8” fastener.  Ensure that the gooseneck is level.  Attach the load cell connector to the cable 
and neatly tuck away any excess cable.  Replace the main cover. 

 
 

 

 

 

 

 

 

 

 

 

 

 

 

 

  

System Alert 

The load cell is designed for in-line loads only.  An excessive transverse load or bending 
moment applied to the gooseneck can permanently damage the load cell.  Care should 
be taken, especially when installing the load cell and attaching samples. 
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13. Appendix D: Fixed Focal Length Lens 

In addition to the 10X zoom lens described in Section 8, the UStretch system can also use fixed 
focal length lenses. Other UStretch models may have a 50mm or 75mm focal length lens and a set 
of lens spacers. Other focal lengths are available and are compatible with the BioTester system.  

Adjusting the Camera Position and Image Magnification 

 

The camera position can be adjusted using the screws on the camera mounting brackets.   

Using the 50 or 75mm focal length lens and lens spacers, it is possible to achieve a field of view 
ranging from 9mm to 30mm.  The details of the appropriate number of spacers and the required 
standoff are shown in the table below. The image magnification can be changed by adding or 
removing spacer tubes located between the camera body and the lens.  Increasing the total spacer 
tube length will result in higher magnification while reducing the tube length will result in lower 
magnification.  Changing the tube length will also change the working distance of the lens.  To 
adjust the vertical position of the lens and camera assembly, loosen the locking screw on the 
camera post and raise or lower the camera until the image is in focus.  It is helpful to make sure 
the lens focus ring is in the middle of its rotation so that fine tuning the image focus can be done 
once the camera position is fixed using the camera post locking screw. 

NOTE: INCREASING THE TOTAL LENGTH OF THE SPACER TUBES WILL INCREASE 
MAGNIFICATION (DECREASE FIELD OF VIEW) AND DECREASE WORKING DISTANCE 
(STAND-OFF).   

The camera lens has two adjustable rings: a focus ring and an iris ring.  The iris adjusts camera 
brightness and is typically left at the brightest possible setting.  Further adjustments to brightness 
can be made in the software (shutter and gain setting).  As mentioned above, the focus ring is used 
to make fine adjustments to the camera focus.   

As the table and graph also show, it is also possible to swap in a lens with a different focal length 
to achieve a different range of magnifications.  This data was collected using the family of fixed 
focal length lenses available from Edmund Optics (the part numbers are shown in the table).  The 
camera has a C-mount connection, making it possible to mount a wide variety of optical 
components to best suit any application.  Currently, only the standard camera is supported. 
 

 

 

Spacer 

(mm)

Stand 

off 

(mm)

pix/c

m

FOV 

(mm)

Stand 

off 

(mm)

pix/c

m

FOV 

(mm)

Stand 

off 

(mm)

pix/c

m

FOV 

(mm)

Stand 

off 

(mm)

pix/c

m

FOV 

(mm)

Stand 

off 

(mm)

pix/c

m

FOV 

(mm)

0 685 78.6 162.8 1070 71 179.3 930 121 105.9

5 100 520 24.6 215 373 34.3 370 329 38.9 820 206 62.2 1540 147 86.8

10 53 935 13.7 125 682 18.8 235 560 22.9 450 404 31.7 950 258 49.6

15 90 993 12.9 185 779 16.4 350 534 24.0 675 366 34.9

20 73 1273 10.1 160 978 13.1 285 711 18.0 535 473 27.0

25 135 1186 10.8 245 859 14.9 455 578 22.1

30 125 1410 9.1 220 959 13.3 400 687 18.6

35 115 1630 7.9 200 1111 11.5 355 797 16.1

40 105 1842 6.9 185 1260 10.2 320 897 14.3

45 100 2068 6.2 170 1392 9.2 295 1003 12.8

35mm (NT56-530)25mm (NT56-529) 50mm (NT56-531) 75mm (NT56-532) 100mm (NT56-675)
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